
 アプリケーションノート 

R01AN3968JJ0103  Rev.1.03  Page 1 of 65 
2019.07.31  

RZ/T1 グループ 
RZ/T1 ソリューションキットを使用した 
EtherCAT 経由のモーションコントロール 

要旨 

本書では、RZ/T1 モーションコントロール・ソリューションキットを使用して、EtherCAT®通信による

モーションコントロールを行う手順について説明します。 

サンプルプログラムはデュアルコアにて制御します。Cortex®-R4 でモーションコントロールを、Cortex-
M3 で EtherCAT 通信を行うことで、モーションコントロールの処理性能を低下させずに通信処理を行えま

す。 

2 つのコア間のデータ交換は共用メモリを介して行われます。セマフォレジスタを使用してアクセス権管

理を行うことで共用メモリへのアクセス競合を回避します。 

EtherCAT 通信は CiA402 ドライブプロファイルを実装することでより実用的な評価が可能です。 

各機能の詳細については、ルネサスのホームページから関連文書を入手してください。 

 

対象デバイス 
RZ/T1 
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このマニュアルの使い方 
 

1. 目的と対象者 

このマニュアルは、RZ/T1 ソリューションキットのセットアップについてユーザに理解していただくため

のマニュアルです。RZ/T1 マイコンの評価を行うユーザを対象にしています。このマニュアルを使用するに

は、電気回路、論理回路、マイクロコンピュータに関する基本的な知識が必要です。 

このマニュアルは、RZ/T1 ソリューションキットパッケージに付属のアプリケーションソフトウェアのイ

ンストールおよび初めて使用する際の使用方法を記述しています。 
 
本マイコンは、注意事項を十分確認の上、使用してください。注意事項は、各章の本文中、各章の最後、注意事項の

章に記載しています。 
 

改訂記録は旧版の記載内容に対して訂正または追加した主な箇所をまとめたものです。改訂内容すべてを記録したも

のではありません。詳細は、このマニュアルの本文でご確認ください。 
 

RZ/T1 グループでは次のドキュメントを用意しています。ドキュメントは最新版を使用してください。最

新版はルネサス エレクトロニクスのホームページに掲載されています。 

 

ドキュメントの種類 記載内容 資料名 資料番号 

データシート ハードウェアの概要と電気的特性 RZ/T1 グループ 
データシート 

R01DS0228JJ 

ユーザーズマニュアル 
ハードウェア編 

ハードウェアの仕様（ピン配置、メ

モリマップ、周辺機能の仕様、電気

的特性、タイミング）と動作説明 
※周辺機能の使用方法はアプリケー

ションノートを参照してください。 

RZ/T1 グループ 
ユーザーズマニュアル 
ハードウェア編 

R01UH0483JJ 

ユーザーズマニュアル 
ソフトウェア編 

CPU 命令セットの説明 RZ/T1 グループ 
ユーザーズマニュアル 
ソフトウェア編 

Cortex-R4 および

Cortex-M3 の命令セッ

トについては、Arm 社

提供のドキュメントを

参照してください。 

ユーザーズマニュアル 
開発環境 

ハードウェア／ソフトウェア・ツー

ルの操作ガイド 
RZ/T1 グループ 
モーションコントロー

ル・ソリューションキッ

ト ユーザーズマニュアル 

R01UH0665JU 

アプリケーションノート ツールのインストールおよび初期設

定の説明 
RZ/T1 モーションコント

ロール・ソリューション

キット 入門ガイド 

R12AN0037JD 
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2. 略語および略称の説明 
 

略語／略称 英語名 日本語名 

CD Compact Disc コンパクトディスク 

CPU Central Processing Unit 中央（演算）処理装置 

MAC Media Access Control メディア・アクセス制御 

PC Personal Computer パーソナル・コンピュータ 

TFTP Trivial File Transfer Protocol トリビアル・ファイル転送プロトコル 

UART Universal Asynchronous Receiver/Transmitter 調歩同期式シリアルインタフェース 

 
すべての商標および登録商標は、それぞれの所有者に帰属します。 

 

3. 関連文書 
 

文書番号 文書名 

R01DS0228JJ RZ/T1 グループ データシート 

R01UH0483JJ RZ/T1 グループ ユーザーズマニュアル ハードウェア編 

R01UH0665JU RZ/T1 グループ 
モーションコントロール・ソリューションキット ユーザーズマニュアル 

R12AN0037JD RZ/T1 モーションコントロール・ソリューションキット 入門ガイド 

R01US0208JU RZ/T1 グループ 
モーションコントロールユーティリティ ユーザーズマニュアル 

R11AN0086JJ RZ/T1 グループ アプリケーションノート 
ソリューションキットファームウェア 

R01AN3968JJ0103 
（本書） 

RZ/T1 グループ アプリケーションノート 
RZ/T1 ソリューションキットを使用した EtherCAT 経由のモーションコントロール 
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1. 動作環境 

本サンプルプログラムは、以下の環境を想定しています。 

 
表 1.1 動作環境 

項目 内容 
使用キット RZ/T1 モーションコントロール・ソリューションキット 
CPU RZ/T1（R-IN エンジン搭載） 

R7S910018 
動作周波数 CPU クロック（CPUCLK）：600MHz（Cortex-R4） 

システムクロック（ICLK）：150MHz（Cortex-M3） 
動作電圧 3.3V 
動作モード SPI ブートモード 
通信プロトコル EtherCAT 

 
統合開発環境 IAR システムズ製 

Embedded Workbench for Arm Version 8.22.2 
ルネサスエレクトロニクス製 
e2 studio Version 7.0.0 

エミュレータ IAR システムズ製 
I-jet Lite 
SEGGER 製 
J-Link 

SSC ツール EtherCAT Technology Group (ETG) 製 
Slave Stack Code (SSC) Tool Version 5.11 

ソフトウェア PLC Beckhoff Automation 製 
TwinCAT®3 

 
統合開発環境、SSC ツール、ソフトウェア PLC のインストール方法の詳細は、R-IN32M3 シリーズ「開発

ツールスタートアップマニュアル」を参照してください。 
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2. RZ/T1 モーションコントロール・ソリューションキットの準備 

RZ/T1 ソリューションキットを使用するために、まず電源、モータ、エンコーダ、通信の各種ケーブルを

接続します。本書の手順に従って、付属の各種ケーブルおよびモータをボード（RZ/T1 モーションコント

ローラ）に接続してください。 

 

2.1 ロジック電源およびモータ電源の接続 

ロジック電源の電圧は、12V～24V DC に設定してください。コントローラがアイドル状態のときの消費

電力は 0.18A 程度ですが、接続しているエンコーダやセンサー等の負荷によっては、0.30A まで上昇するこ

とがあります。 

付属のモータは、24V での動作を想定しています。電源は、図 2.1 に示すように、インバータボード上の

5 ピンコネクタ J2 を介して接続します。本ソリューションキットには、J2 への 5 ピン接続プラグと電源接

続ケーブルを付属しています。ロジック用とモータ用で、個別に電源供給することを推奨します。 

モータ電源の電圧は 48V を超えないようにしてください。また、（負荷に依存する）消費電流は 8A を超

えないようにしてください。電流がこの上限値を超えると、インバータは電源を遮断します。なお

MOSFET は、モータ巻線間のショートに対しても耐性があります。 

 

  

 
 

図 2.1 電源コネクタ（J2）接続 

モータ電源 ロジック電源 
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2.2 モータ巻線の接続 

モータ巻線は、インバータボード上の J1 または J3 に接続します。付属のモータを接続する場合、第 1
チャネルに相当する左側のコネクタ（J1）を選択します。追加のモータ（本ソリューションキットには付属

していません）がある場合、そのモータは第 2 チャネルに相当する右側のコネクタ（J3）に接続することが

できます。付属のモータは、接続の際に端子の割り当てを設定する必要がなく、すぐに接続、使用すること

ができます。 

図 2.2 に、モータ巻線の接続位置を示します（実際のケーブルの色は異なる場合があります）。 

 

 

 
 

図 2.2 J1 へのモータ巻線の接続（実際のケーブルの色は異なる場合があります） 

J1 
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2.3 エンコーダの接続 

付属のエンコーダは、D-sub 15 ピン（DB15）コネクタを介してコントローラボード上の P1 に接続しま

す。追加のエンコーダ（本ソリューションキットには付属していません）がある場合、そのエンコーダはコ

ントローラボード上の P2 に接続することができます。 

図 2.3 に、コントローラボードの P1 の位置を示します。付属のエンコーダはモータと一体になってお

り、すぐに接続、使用することができます。 

 

 

 
 

図 2.3 エンコーダの接続 
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2.4 ホールセンサの接続 

本ソリューションキットでは、ホールセンサをボードに接続する方法として、コネクタ P5 に接続する方

法と、P1 に接続したエンコーダとともに接続する方法があります。どちらの接続を有効とするかは、DIP ス

イッチ S2 の 0 番ピン（S2-0）の設定で決めることができます。 

• S2-0＝ON： P1 経由で接続 

• S2-0＝OFF： P5 経由で接続（本書で使用） 
 
付属のモータは、P5 経由でホールセンサを接続します。図 2.4 のように接続し、その際に S2-0 が OFF に

セットされていることを確認してください。実際のケーブルの色は図 2.4 の写真の色とは異なる場合があり

ます。また、写真では表示されていませんが、付属ケーブルにはシールド接続部が存在します。 

 

 

 
 

図 2.4 ホールセンサの接続（実際のケーブルの色とは異なる場合があります） 
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2.5 RS232 通信ケーブルの接続 

コントローラボードの P11 で使用可能なシリアルインタフェースを介してホスト PC との通信接続を行い

ます。通信ケーブルはストレート結線による RS232 インタフェース（オス―メスの D-sub9 ピン（DB9）コ

ネクタ）を使用します。この通信ケーブルは、本ソリューションキットに付属されています。お使いの PC
がシリアルインタフェースに対応していない場合は、シリアル―USB 変換ケーブルを使用してください。

図 2.5 に、シリアルインタフェースの接続写真を示します。 

 

 

 
 

図 2.5 ホスト PC とのシリアル接続 
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2.6 JTAG インタフェースの接続 

本接続は、デバッグによる開発評価を行う場合、または新しいファームウェアをダウンロードするときに

行います。JTAG コネクタは IAR 社指定の MIPI20 コネクタを採用しています。コネクタは 2 極で、ピン間

隔は 1.27mm ピッチとなっています。 

本ソリューションキットには、IAR 社の I-jet Lite デバッガが付属しています。本デバッガは、図 2.6 のよ

うにコントローラボード上のコネクタ P9 に接続します。 

 
【注意】コネクタを差し込む際は、ピンが曲がらないように注意してください。 
 

 

 
 

図 2.6 ハードウェアデバッガ接続 
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2.7 Ethernet インタフェースの接続 

PC または PLC への Ethernet 接続には、2 つの RJ-45 コネクタ（P12、P13）のいずれかを使用します。

EtherCAT サンプルプログラムを実行する際にはいずれのコネクタも使用できます。 

 

 

 
 

図 2.7 Ethernet 接続 
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2.8 フラッシュメモリへのモータパラメータ保存 

RZ/T1 で EtherCAT 経由のモーションコントロールを実施するためのサンプルプログラムでは、外付けフ

ラッシュにモータパラメータを格納します。これには、本ソリューションキットに付属のモーションコント

ロール GUI を使用します。すでに RZT1 ソリューションキットを使用して評価を行っている場合は、ボード

を出荷時の状態に戻します。 

本ソリューションキットボードは、モーションコントロールファームウェアを書き込んだ状態で出荷され

ています。本書で説明するサンプルプログラムをシリアルフラッシュから実行する場合、モーションコント

ロールファームウェアは上書きされます。これを元の状態に戻すには、他のサンプルプログラムを使用する

場合と同様に、IAR I-jet Lite を接続し、EWARM で任意のプロジェクトを起ち上げます。図 2.8 に示すよう

に、「Project」メニューから「Download」を選択し、「Download file…」をクリックします。 

 

 

図 2.8 「Download file」機能の選択 
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ここで、ファイルを開くためのダイアログが表示されますので、付属 CD 内の「Software\Sample.projects」
ディレクトリから、「TestProject.out」を選択します。 

 

 

図 2.9 ダウンロードするファイルの選択 

 

ここで、図 2.10 のようなエラーメッセージが表示されますが、「OK」をクリックします。シリアルフ

ラッシュへのダウンロードが開始されます。 

 

 

図 2.10 プログラム書き込みの開始 

 

ダウウンロードが完了したら、モーションコントロールファームウェアの書き込みが成功したかどうか、

以下の手順で確認を行ってください。 

1. ボードの電源を切る 

2. IAR I-jet Lite を取り外す 

3. ボードに電源を再投入する 
 
ボードへの電源再投入後、ボード上の LED のうち、LED9、LED7、LED6 が点灯し、LED8 が点滅するこ

とを確認してください。これは、モーションコントロールファームウェアが正しく書き込まれていることを

示します。 

次に、お使いの PC にモーションコントロールファームウェアをインストールします。RZ/T1 モーション

コントロールユーティリティは、Windows XP およびそれ以降（Windows 10 まで）のバージョンに対応して

います。また、Microsoft.NET Framework 4.0 が必要になりますので、お使いの PC にインストールされてい

ない場合はインストールしてください。ファームウェアのインストールには、次の 2 つの方法があります。 

 

• RZ/T1 ソリューションキット CD 内の“\Software\RZT1.Motion.Control.Utility”ディレクトリから、

Setup.exe ファイルを実行 

•  RZ_T1_Utility.msi を実行 
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いずれの方法でインストールした場合でも、最初に図 2.11 に示すダイアログが表示されます。 

 

 

図 2.11 RZ/T1 Motion Utility インストール画面 

 

「Next」をクリックすると、図 2.12 に示すように、インストール先のフォルダを指定する画面に移行しま

す。インストール先はどのフォルダでも問題ありませんが、デフォルトで指定されているフォルダを推奨し

ます。 

 

 

図 2.12 インストール先フォルダ指定画面 
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「Next」をクリックし、インストールを開始します。インストール完了後、RZ/T1 Motion Utility が起動し

ます。起動すると、以下の画面が表示されます。 

 

図 2.13  RZ/T1 Motion Utility 起動画面 

 

図 2.13 に示すように、メインメニューから「Connect」をクリックし、RZ/T1 モーションコントローラと

の通信に使用するシリアルインタフェースを選択します。「RS232」タブを選択し、図 2.14 に示すドロップ

ダウンリストから接続するシリアルポート番号を指定します。ポート番号は、MS-Windows 上のデバイスマ

ネージャで確認してください。 

 
【注】 シリアルポート名は、あらかじめ定義されたドロップダウンリストから選択します。リストに該当の

シリアル COM ポート番号がない場合、任意の番号を入力可能です。 
 

 

図 2.14 シリアル COM ポート番号の選択 
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接続先のシリアル COM ポートが確定すると、「RZ/T1 Motion Utility」画面は図 2.15 のように表示され、

画面左下で接続が確立されたことを確認できます。 

 

 

図 2.15 シリアル接続の確立 

 

メインメニューの「Connect」表示が「Disconnect」になり、接続ポートが画面左下に表示されます。 
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接続が確立されたら、「File」メニューから「Import」を選択します。「Open File」ダイアログが表示され

ますので、付属 CD 内の“\Software\Motor.Configuration”ディレクトリから“Speeder.Motion.yymmdd.mtr”
ファイルを選択します。 

 

 

図 2.16 モータパラメータファイルのインポート 
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「File」メニューから「Save to FLASH」を選択し、RZ/T1 の外付けフラッシュメモリにパラメータをコ

ピーします。 

 

 

図 2.17 モータパラメータのフラッシュメモリへのコピー 

  



RZ/T1 グループ  

R01AN3968JJ0103  Rev.1.03  Page 20 of 65 
2019.07.31  

RZ/T1 ソリューションキットを使用した

EtherCAT 経由のモーションコントロール 

3. EtherCAT 通信の準備 

本章では、EtherCAT サンプルプログラムを RZ/T1 のボード上で動作させるための事前準備について説明

します。 

 

3.1 TwinCAT®3 のインストール 

TwinCAT®3 は簡単な操作でインストールできます。TwinCAT®3 は以下のページからダウンロードできま

す。 

http://www.beckhoff.com/english/download/tc3-downloads.htm?id=1905053019883865 

 

スクリーンショット画面や操作方法は、ソフトウェアのバージョンの変更に伴い、予告なく変更される場

合があります。上記 URL をクリックすると、図 3.1 に示す画面が表示されます。 

 

 

図 3.1 TwinCAT®3 ダウンロードページ 
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上記ダウンロードページから、ソフトウェアパッケージ「TE1xxx|Engineering」を選択すると、ユーザ登

録が要求されます。登録は無料です。登録後、ダウンロードページへのリンク先の URL が記載された E
メールが届きます。ダウンロードが完了したら、PC に TwinCAT®3 をインストールします。インストールは

各手順に従って行ってください。以下にインストール時の推奨事項を示します。 

• インストール時にシリアル番号の入力を要求されますが、シリアル番号のフィールドは空白のまま

で構いません。 

• 「Select Installation Level」ダイアログでは「TwinCAT PLC – IEC 61131-3 PLC system」を選択しま

す。 

• 「Select Installation Type」ダイアログで「30 days demo version」を選択します。 
（30 日を超えても EtherCAT サンプルプログラムは使用可能です。） 

• すべての機能をインストールします。 

• インストール先のディレクトリは「C:\TwinCAT」を推奨します。 
 
インストール後、インストールが正常に行われたかどうか確認するため、TwinCAT®3 のネットワークア

ダプタを選択します。TwinCAT®3 を起動し、スタートアップ画面の「TwinCAT」メニューから、“Show 
Realtime Ethernet Compatible Devices”を選択してください。 

 

 

図 3.2 TwinCAT®3 に利用可能なネットワークアダプタの確認 
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TwinCAT®3 に、お使いの PC 内のネットワークアダプタの一覧がカテゴリ別に表示されます。図 3.3 に示

すように、“Compatible devices”以下に、アダプタが少なくとも 1 種類以上表示されますので、そのうちの

1 つを選択して「Install」をクリックしてください。選択したネットワークアダプタが“Installed and ready to 
use devices (realtime capable)”以下に移動します。 

 

 

図 3.3 互換性のあるネットワークアダプタの選択 
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3.2 サンプルコードの取得 

RZ/T1 ソリューションキットに使用するサンプルコードは、付属の CD からダウンロードできます。最新

版はルネサスのホームページをご確認ください。 

 

3.3 ESI ファイルのコピー 

以下に示すディレクトリから、ESI (EtherCAT Slave Information)ファイル

“Renesas_RZT1_DRIVE_IT!_CiA402.xml”を取得してください。 

 
\Biplane_EtherCAT_Vx.xx_multi\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual\CiA402_Motion_C

ontrol\RenesasSDK\ESI_File 

 

取得したファイルを、TwinCAT®3 がインストールされている以下のフォルダにコピーしてください。 

\TwinCAT\3.x\Config\Io\EtherCAT 

 

 

図 3.4  ESI ファイルのコピー 
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3.4 スレーブスタックコードの生成 

EtherCAT 通信を実行するためには、Beckhoff 社が提供するコード生成ツールを使用して、EtherCAT ス

レーブコードを生成する必要があります。コード生成は、前章でコピーした ESI ファイルのスレーブプロパ

ティの形式的記述に基づいて行われます。 

 
(1) SSC ツールを起動 

下記の場所にある SSC プロジェクトファイル“RZT1_CiA402_Motion_Control.esp”をダブルクリックして

SSC ツールを起動します。 

 
\Biplane_EtherCAT_Vx.xx_multi\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual\CiA402_Motion_C

ontrol\RenesasSDK\ssc_project 

 
(2) スレーブスタックコードの生成 

SSC ツールで、[Project] -> [Create new Slave Files] を選択します。「Start」をクリックすると、スレーブス

タックコードが以下のディレクトリに生成されます。 

 
\Biplane_EtherCAT_Vx.xx_multi\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual\CiA402_Motion_C

ontrol\RenesasSDK\ssc_project\Src 

 

「OK」をクリックし、「Close」ボタンで SSC ツールを終了します。 

 

 

図 3.5 EtherCAT スレーブスタックコードの生成 
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(3) パッチコマンドの準備 

最後に、お使いの PC にパッチファイルをインストールし、環境変数として使用できるようにします。以

下のウェブサイトから GNU パッチプログラム（Ver.2.5.9 以降）をダウンロードしてください。 

 
http://gnuwin32.sourceforge.net/packages/patch.htm 

 

ダウンロードした patch.exe.ファイルを保存し、環境変数への（なるべく短い）ストレージパスを追加し

ます。Windows のコントロールパネルから、「システム」->「システムの詳細設定」を選択します。「シス

テムのプロパティ」ダイアログが表示されますので、「環境変数」をクリックします。 

 

 

図 3.6 新しい環境変数の追加 

 

システム変数の一覧から「Path」を選択し、「編集」をクリックします。パッチファイル格納先のパスを

既存のサーチパスに追加します。本サンプルプログラムでは“C:\Program Files (x86)\GnuWin32\bin”です。

「OK」を 2 回クリックし、変更を適用します。 

  

http://gnuwin32.sourceforge.net/packages/patch.htm
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図 3.7 システム変数の「Path」の編集 

 
(4) パッチの適用 

次に、パッチを 1 回実行します。 

以下の場所にある“apply_patch.bat”ファイルをダブルクリックします。 

 
\Biplane_EtherCAT_Vx.xx_multi\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual\CiA402_Motion_C

ontrol\RenesasSDK 

 

このファイルのスクリプトがスレーブスタックコードを含むディレクトリへと移動し、本サンプルプログ

ラムへの修正パッチを適用します。 

図 3.8 に示すような“Patching file…”メッセージが表示されない場合は、パッチが適用されていません。

この場合、“apply_patch.bat”を右クリックし“Run as administrator”を選択してください。 

 

 

図 3.8 パッチファイル実行メッセージ 

 

これで、EtherCAT プロジェクトを実行するための準備は完了です。 
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3.5 サンプルプロジェクトの構築 

3.5.1 IAR EWARM を使用したサンプルプロジェクトの構築 

本章では、IAR EWARM 環境を使用して EtherCAT 通信用サンプルプロジェクトを実行する方法について

説明します。 

 
(1) EWARM へプロジェクトをロード 

【注】 本書では IAR EWARM のバージョン 8.22.2 を使用していますが、IAR EWARM のバージョンが更新

されている場合があります。プロジェクトは最新のバージョンでは試行していないため、最新のバー

ジョンで問題が発生した場合にはバージョン 8.22.2 に戻してください。 
 

IAR EWARM は、ご使用のコンピュータにインストールされている必要があります。インストールしてい

ない場合、IAR EWARM インストールパッケージに同梱の関連ドキュメントの手順に従って、インストール

を実施してください。 

Windows のスタートメニューから、[すべてのプログラム] -> [IAR Systems] -> [IAR Embedded Workbench 
for ARM 7.2] -> [IAR Embedded Workbench] を選択し、EWARM を起動します。この手順を再度行い、別の

EWARM を起動します。一方を Cortex-R4 コア、他方を Cortex-M3 コアのデバッグに使用します。 

 
(2) Cortex-M3 プロジェクトのロードとビルド 

Cortex-M3 側の EWARM で、以下を実行します。 

[File] -> [Open] -> [Workspace] で、以下のディレクトリにある“main.eww”ファイルをダブルクリック

し、ワークスペースを開きます（図 3.9 参照）。 

 
\Biplane_EtherCAT_Vx.xx_multi\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual\CiA402_Motion_C

ontrol\IAR 

 

 

図 3.9  EWARM 上でプロジェクトのワークスペースを開く  
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次に、[Project] -> [Rebuild All] で、プロジェクトをビルドします（図 3.10 参照）。すべてのプロジェクト

が適切に設定されますので、変更の必要はありません。その後、バイナリファイル“cm3_IAR.bin”が以下

のディレクトリに生成されます。 

 
\Biplane_EtherCAT_Vx.xx_multi\Cortex-M3\cm3_boot_binary 

 

プロジェクト実行によるエラーは生じません。ワーニングが発生しますが、無視します。 

 

 

図 3.10 EWARM 上でプロジェクトをリビルドする 

 
(3) Cortex-R4 プロジェクトのロードとビルド 

Cortex-R4 側の EWARM で、以下を実行します。 

[File] -> [Open] -> [Workspace] で、以下のディレクトリにある“Biplane.eww”ファイルをダブルクリック

し、ワークスペースを開きます。 

 
\Biplane_EtherCAT_Vx.xx_multi\Cortex-R4\prj\iar 

 

次に、[Project] -> [Rebuild All] を選択し、ビルドを実行します。ここでもワーニングが発生しますが、無

視します。（図 3.9、図 3.10 参照） 
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3.5.2 Renesas e2 studio を使用したサンプルプロジェクトの構築 

本章では、e2 studio 環境を使用して EtherCAT 通信用サンプルプロジェクトを実行する方法について説明

します。 

 
(1) e2 studio へプロジェクトをロード 

【注】 本書では Renesas e2 studio のバージョン 7.0.0 を使用していますが、バージョンが更新されている

場合があります。プロジェクトは最新のバージョンでは試行していないため、最新のバージョンで問

題が発生した場合にはバージョン 7.0.0 に戻してください。 
 

Renesas e2 studio は、ご使用のコンピュータにインストールされている必要があります。インストールして

いない場合、Renesas e2 studio インストールパッケージに同梱の関連ドキュメントの手順に従って、インス

トールを実施してください。 

サンプルプログラムには Cortex-M3 のプロジェクトと Cortex-R4 のプロジェクトの両方が含まれていま

す。はじめに、Cortex-M3 のプロジェクトをビルドしてください。Cortex-M3 プロジェクトのビルド結果は

Cortex-R4 プロジェクトに反映されます。 

各プロジェクトのビルド手順については、以下を参照してください。 

 

(2) Cortex-M3 プロジェクトのロードとビルド 

A) e2 studio を起動 

以下のディレクトリにある“e2sws.bat”ファイルをダブルクリックし、ワークスペースを開きます。 
 

\Biplane_EtherCAT_Vx.xx_multi\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual\CiA402_Motion
_Control\GCC 

 
ワークスペースが開いたら、「Welcome」画面を閉じてください。 

 

図 3.11 Welcome to e2 studio 

1 
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B) サンプルプロジェクトのインポート 

e2 studio の「File」メニューから「Import...」を選択し、「Import」ダイアログを開きます。以下の手順

に従って、インポートを完了してください。 

 

 

図 3.12 e2 studio インポート手順 1 

 

  

1 

2 
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図 3.13 e2 studio インポート手順 2 
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C) サンプルプロジェクトのビルド 

「Project Explorer」画面の“sample_cm3 [HardwareDebug]”を右クリックして「Build Project」を選択し、

サンプルプロジェクトをビルドします。 

 

 

図 3.14 e2 studio 上で Cortex-M3 のサンプルプロジェクトをビルドする 

 

  

１ 

2 



RZ/T1 グループ  

R01AN3968JJ0103  Rev.1.03  Page 33 of 65 
2019.07.31  

RZ/T1 ソリューションキットを使用した

EtherCAT 経由のモーションコントロール 

 

(3) Cortex-R4 プロジェクトのロードとビルド 

A) e2 studio を起動 

Windows のスタートメニューから、[すべてのプログラム] -> [Renesas electronics e2studio] -> [e2 studio] 
を選択し、e2 studio を立ち上げます。 

 

B) 新規ワークスペースの作成 

「Workspace Launcher」ダイアログで、プロジェクトを展開したフォルダを選択します。 

 

 

図 3.15 e2 studio「Workspace Launcher」ダイアログ 

 

【注】 e2 studio 起動時に「Workspace Launcher」ダイアログが表示されない場合、e2 studio の「File」メ

ニューから [Switch workspace] -> [Other...] を選択してダイアログを表示します。 
 

C) サンプルプロジェクトのインポート 

e2 studio の「File」メニューから 「Import...」を選択し、「Import」ダイアログを開きます。以下の手順

に従って、インポートを完了してください。 

  

1 

2 
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図 3.16 e2 studio インポート手順 1 
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図 3.17 e2 studio インポート手順 2 
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D) サンプルプロジェクトのビルド 

「Project Explorer」画面の“Biplane [HardwareDebug]”を右クリックして「Build Project」を選択し、サン

プルプロジェクトをビルドします。 

 

 

図 3.18 e2 studio 上で Cortex-R4 のサンプルプロジェクトをビルドする 
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3.6 サンプルプロジェクトの実行 

プロジェクトの起動方法は、デバッグ対象のコアによって異なります。通常は Cortex-R4 コアで動作する

アプリケーションのデバッグを行いますので、はじめに Cortex-R4 コアのデバッグ方法について説明しま

す。次に、Cortex-M3 コア用コードのデバッグ方法について説明し、最後にサンプルコードを実行します。 

 

3.6.1 IAR EWARM におけるサンプルプロジェクトの実行 
 

(1) Cortex-R4 コアのデバッグ 

Cortex-R4 側の EWARM で、[Project] -> [Download and Debug] を選択し、フラッシュメモリにデータを書

き込みます（図 3.19 の 1）。 

 

 

図 3.19 Cortex-R4 コアのプログラム実行開始 

 

Cortex-M3 コア側の EWARM を終了し、別の EWARM 上で「Go」ボタンをクリックして Cortex-R4 コア

のプログラム実行を開始してください（図 3.19 の 2）。 
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(2) Cortex-M3 コアのデバッグ 

Cortex-M3 コアのデバッグを行う場合、Cortex-R4 コア側の EWARM で、以下を実行します。 

 
(a) デバッガを起動する前に、Cortex-R4 プロジェクトの“Debugger”の「Extra Options」タブで、以下

の 2 行を追加します（図 3.20）。 
 

--drv_default_breakpoint=1 
--jet_sigprobe_opt=shared 

 

 

図 3.20 Cortex-M3 のデバッグのためのデバッガオプション変更 

 
(b) 次に、r_cg_main.c において、R_MAIN_UserInit()の後ろにカーソルを合わせ、「Run the Cursor」ボタ

ンをクリックし、カーソル位置までコードを実行します（図 3.21）。 
 

(c) Cortex-M3 側の EWARM 上で、「Project」メニューから「Attach to running target」を選択し（図

3.22）、デバッガが開いたら Cortex-M3 のデバッグを行います。 
 
デバッグ中、2 つのコアは周辺レジスタやメモリ領域など共通資源にアクセスします。Cortex-M3 コアの

デバッグ対象となるコードの箇所によっては、Cortex-R4 コアの実行が求められる場合があります。 
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図 3.21 Cortex-R4 側 EWARM でのブレークポイント設定 

 

 

図 3.22 Cortex-M3 コアのデバッグ開始 
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(3) デバッグを行わないサンプルコードの実行 

3.5.1 章の 2 つのコアのサンプルプロジェクトのビルドが完了したら、Cortex-M3 コア側の EWARM を閉じ

てください。Cortex-R4 コア側の EWARM 上で、図 3.23 に示すように、「Download and Debug」ボタンをク

リックし（図 3.23 の 1）、続けて「Go」ボタンをクリックしてください（図 3.23 の 2）。 

 

 

図 3.23 Cortex-R4 プログラム実行開始 

 

Cortex-M3 コア用コードは Cortex-R4 プロジェクトの一部になっており、Cortex-R4 により Cortex-M3 の

ワークスペースにコピーされます。また、Cortex-R4 は Cortex-M3 のリセットを解除します。そのため、

Cortex-R4 を起動すると、Cortex-M3 コアと Cortex-R4 コアの両方でプログラムの実行が開始されます。 

コードがデバッガ経由でフラッシュに格納されると、プログラムの実行は次回以降の電源投入後に自動的

に開始します。 
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3.6.2 Renesas e2 studio におけるサンプルプロジェクトの実行 
 

(1) Cortex-R4 コアのデバッグ 

Cortex-R4 プロジェクト側の e2 studio で、以下を実行します。 

 

 

図 3.24 e2 studio におけるプログラム実行開始手順 1 

 

 

図 3.25 e2 studio におけるプログラム実行開始手順 2 
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図 3.26 e2 studio におけるプログラム実行開始手順 3 

 

 

図 3.27 e2 studio におけるプログラム実行開始手順 4 
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(2) Cortex-M3 コアのデバッグ 

Cortex-M3 コアのデバッグを行う場合、Cortex-R4 プロジェクト側の e2 studio で、以下を実行します。 

 
(a) r_cg_main.c において、R_MAIN_UserInit()の後ろにカーソルを合わせ、「Run to Line」 をクリック

し、カーソル位置までコードを実行します。 
 

 

図 3.28 Cortex-R4 側 e2 studio でのブレークポイント設定 
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Cortex-M3 プロジェクト側の e2 studio で、以下を実行します。 

 
(a) 「Project Explorer」画面の“sample_cm3 [HardwareDebug]”を選択し、「Debug」ボタンをクリックし

て、デバッグを実行します。 
 

 

図 3.29 Cortex-M3 のデバッグ開始手順 1 

 

 

図 3.30 Cortex-M3 のデバッグ開始手順 2 

 

  

1 

2 

1 

2 



RZ/T1 グループ  

R01AN3968JJ0103  Rev.1.03  Page 45 of 65 
2019.07.31  

RZ/T1 ソリューションキットを使用した

EtherCAT 経由のモーションコントロール 

 

 

図 3.31 Cortex-M3 のデバッグ開始手順 3 

 

デバッグ中、2 つのコアは周辺レジスタやメモリ領域など共通資源にアクセスします。Cortex-M3 コアの

デバッグ対象となるコードの箇所によっては、Cortex-R4 コアの実行が求められる場合があります。 
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(3) デバッグを行わないサンプルコードの実行 

3.5.2 章の 2 つのコアのサンプルプロジェクトのビルドが完了したら、Cortex-M3 コア側の e2 studio を閉じ

てください。Cortex-R4 コア側の e2 studio 上で、図 3.32 に示すように、「Download and Debug」ボタンをク

リックし（図 3.32 の 1）、続けて「Go」ボタンをクリックしてください（図 3.32 の 2）。 

 

 

図 3.32 Cortex-R4 プログラム実行開始 

 

Cortex-M3 コア用コードは Cortex-R4 プロジェクトの一部になっており、Cortex-R4 により Cortex-M3 の

ワークスペースにコピーされます。また、Cortex-R4 は Cortex-M3 のリセットを解除します。そのため、

Cortex-R4 を起動すると、Cortex-M3 コアと Cortex-R4 コアの両方でプログラムの実行が開始されます。 

コードがデバッガ経由でフラッシュに格納されると、プログラムの実行は次回以降の電源投入後に自動的

に開始します。 
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4. TwinCAT®3 との通信確認 

4.1 TwinCAT®3 の起動 

(1) 以下のいずれかの方法で“TwinCAT XAE”プログラムを起動します。 

• タスクトレイから、[TwinCAT Config Mode] -> [TwinCAT XAE (VS2010)] を選択 

• スタートメニューから、[All Programs] -> [Beckhoff] -> [TwinCAT 3] -> [TwinCAT XAE (VS2010)] 
を選択 

(2) プログラムが起動したら、図 4.1 に示すように [New TwinCAT Project] を選択し、新規 TwinCAT 
XAE プロジェクトを作成します。新規プロジェクトの作成には数 10 秒かかります。画面右下のプロ

グレスバーで進捗状況を確認できます。 
 

 

図 4.1 TwinCAT®3 起動画面 
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図 4.2 新規プロジェクトの作成 

 

TwinCAT®3 の次のステップに進む前に、RZ/T1 上の EtherCAT プロジェクトが起動・実行中であることを

確認してください（3.6 章参照）。 
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(3) [Devices] を右クリックし、[Scan] を選択します（図 4.3）。 

[Scan] をクリックすると、ネットワーク上の一部のデバイスが自動検出されない可能性があること

を知らせるメッセージが表示されます。「OK」をクリックすると、ネットワーク上で利用可能なデ

バイスの一覧が表示されます。RZ/T1 ソリューションキットボードで使用するネットワークコント

ローラに接続されている EtherCAT デバイスを選択し（図 4.4 参照）、「OK」をクリックします。 
 

 

図 4.3 新たなデバイスのネットワークスキャン 
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(4) [EtherCAT] のみを選択し、「OK」をクリックします。 
 

 

図 4.4 適切な EtherCAT デバイスの選択 

 

「OK」をクリックすると、“scan for boxes”および“activate Free Run”を行うかどうかを尋ねられます。

どちらも「YES」を選択します。Free Run 有効時は STER および ERR の LED が点滅し、LA P12（P13 を

ネットワーク接続に使用している場合は LA P13）の LED が高速点滅します。 

同じ環境、同じプロジェクトで「Scan」を再度行うと、新たなデバイスは検出されない旨のメッセージが

表示されます。ネットワークに変更がないため、このメッセージが出ても問題ありません。 
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(5) スキャン結果は、EEPROM にデータが書き込まれるまで“Box 1 (Pxxxxxxxx Rxxxxxxxx)”と表示さ

れます（図 4.5 参照）。EEPROM が書き換えられると、Box 1 には“Drive x (DRIVE IT! CiA402)”と

表示されます。EEPROM の書き換えについては 4.2 章で説明します。 
 

 

図 4.5 デバイスのスキャン結果 
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(6) “Box 1”が正しく表示されない場合は、EtherCAT 接続に使用するネットワークアダプタのプロパ

ティを確認してください。MS Windows で「ネットワークと共有センター」を開き、EtherCAT 接続に

使用するネットワークアダプタを右クリックし、「プロパティ」を選択すると、このアダプタがサ

ポートしているプロトコルやサービス一覧が表示されます。 

以下の画面のように、EtherCAT に関係のないアイテムのチェックをすべて外し、デバイスのスキャ

ンを再試行してください。 
 

 

図 4.6 EtherCAT に使用するネットワークアダプタのトラブルシューティング 
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4.2 RZ/T1 モーションコントロール・ソリューションキットでの EEPROM データ更新 

TwinCAT®3 と RZ/T1 モーションコントロール・ソリューションキット間の接続が確立されたら、本キッ

トの EEPROM データを TwinCAT®3 から更新できます。EEPROM にはベンダ ID や製品 ID といった識別情

報が格納されています。 

RZ/T1 ソリューションキットご購入時点では EEPROM はブランクになっており、Box 1 には“PFFFFFFFF 
RFFFFFFFF”と表示されています。使用履歴のあるボードでは、EEPROM に別のデータが入っている場合

があるため、次の方法で EEPROM を更新することをお薦めします。 

EEPROM を更新するには、図 4.7 に示すように、Box 1 をダブルクリックし（図 4.7 の 1）、

「EtherCAT」タブを選択後（図 4.7 の 2）、「Advanced settings…」ボタンをクリックしてください（図 4.7
の 3）。 

 

 

図 4.7 EEPROM の更新 

 

図 4.8 に示すように、「Advanced Settings」のリストを展開し、“Hex Editor”を選択します（図 4.8 の

1）。「Hex Editor」表示画面の「Download from List…」ボタンをクリックすると（図 4.8 の 2）、所望の

EEPROM の内容を使用可能なデバイスのリストが表示されます。 

リストの下部にルネサス製のデバイスがいくつか表示されますので、“DRIVE IT! CiA402”を選択し、

「OK」をクリックします（図 4.9 参照）。 
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図 4.8 EEPROM ファイルのダウンロードに使用する Hex Editor の選択 

 

 

図 4.9 適切な EEPROM 記述ファイルの選択 

 

EEPROM にデータがダウンロードされます。ダウンロードが完了すると、データが自動的に検証されま

す。 
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ここで、図 4.3 のデバイススキャンを再度行います。TwinCAT®3 が再度デバイスへのスキャンを行い、

RZ/T1 ソリューションキットボードで EEPROM の記述データが更新されたことを検出します。続いて、検

出されたデバイスが「Check Configuration」ダイアログに表示されます。図 4.10 に示すように、「Copy 
All」をクリックし、“DRIVE IT! CiA402”デバイスを「Configured Items」にコピーします（図 4.10 の

1）。デバイスの表示マークが緑色になったら「OK」をクリックし（図 4.10 の 2）、ダイアログを閉じま

す。 

 

 

図 4.10 “Configured Items”に検出デバイスをコピー 

 

これで、TwinCAT®3 プロジェクトを実行するための準備は完了です。 
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4.3 通信状況の確認 

TwinCAT®3 と RZ/T1 のソフトウェアが正しく動作していることを確認するには、TwinCAT®3 の通信状況

を確認することをお薦めします。図 4.11 に示すように、“Drive 1 (DRIVE IT! CiA402)”をダブルクリック

し（図 4.11 の 1）、「Online」タブ（図 4.11 の 2）で“Current State”が“OP”（動作可能）となっている

か確認します（図 4.11 の 3）。 

 

 

図 4.11 通信状況の確認 

 

“OP”（“INIT”（初期状態））でない場合は、通信の確立を再度行ってください。図 4.12 に示す

「Restart TwinCAT (Config Mode)」ボタンをクリックすると、 

• TwinCAT System を Config Mode で再起動し、 

• I/O デバイスをロードし、 

• Free Run を有効にする 

ことが求められます。いずれも「Yes」をクリックしてください。通信が再度確立されると、図 4.11 の

「Online」タブのデバイス状況が“OP”に変わります。 
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図 4.12 TwinCAT®3 システムを Config Mode で再起動する 
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4.4 RZ/T1 モーションコントロール・ソリューションキットへのデータ送信 

RZ/T1 モーションコントロール・ソリューションキットとのデータ通信を行います。図 4.13 に示すよう

に、“Drive 1 (DRIVE IT! CiA402)”ツリーを展開し、さらに“Module 1”をすべて展開します。快適に操作

するために、入力値を別のウォッチウィンドウに追加します。値を右クリックし（図 4.13 の 1）、「Add to 
watch」を選択します（図 4.13 の 2）。 

 

図 4.13 ウォッチウィンドウに値を追加 

この作業を Module 1 への 5 つの入力値すべてに繰り返すと、図 4.14 に示すような常時更新されるウォッ

チウィンドウが表示されます。 

 

図 4.14 Module 1 入力値ウォッチ 

【注】 “入力”、“出力”は、TwinCAT®3 の GUI 上で EtherCAT PLC から見たものです。したがって、ド

ライブ（RZ/T1 ソリューションキット）にコマンドを送信する場合は出力変数を用います。一方、ド

ライブからのフィードバックは入力変数によって反映されます。 
 

TwinCAT®3 のツリー表示の“Outputs”以下の値はオンラインで変更できます。図 4.15 に示すように、

“Controlword”をクリックすると、TwinCAT®3 画面上に変数の詳細情報が表示されます（図 4.15 の 1）。

“Controlword”の値を EtherCAT を介してドライブに送信するには「Online」タブをクリックします（図 4.15
の 2）。「Write」ボタンをクリックすると（図 4.15 の 3）、“Controlword”を別形式で入力するダイアログ
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が表示されます。10 進数で 128 と入力してください。「OK」ボタンをクリックすると（図 4.15 の 4）、画

面が閉じて値が送信されます。 

コントロールワード 128（もしくは 0x80）はドライブを初期状態にするコマンドの一種です。この値を送

信する前にウォッチウィンドウのエラーコードが 0 でない場合は、0 にしてください。ステータスワードの

値は 545 にしてください。 

 

 

図 4.15 ドライブをリセットするコントロールワードの送信 

ドライブ動作は、コントロールワード 15（もしくは 0x0F）を送信することで開始されます。 

次に、“Target position”、“Profile velocity”、“Profile acceleration”、“Profile deceleration”の値を同様

の方法で送信します。以下は、初めて評価を行う場合の推奨値です。 

• Target position：10000 

• Profile velocity：200 

• Profile acceleration：50 

• Profile deceleration：50 
 
図 4.16 は“Profile velocity”の値の送信例です。他の値も同様の方法で送信します。値を送信後、コント

ロールワード 31（0x1F）を送信することで、モータの回転が開始されます。モータは、あらかじめ設定し

た加速度、速度、減速度で、目標位置に到達するまで回転します。現在の速度と位置をウォッチウィンドウ

で確認できます。動作前、動作中、動作後の各スクリーンショットを図 4.17 に示します。 

 

2 

3 

1 
4 
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図 4.16 Profile velocity のコントロールワードの送信 

 

 

図 4.17 モータ回転中のウォッチ値の変化 

 
パラメータを自由に変更して、実験を行うことができます。コントロールワードが含まれる“コマンド

セット”およびエラーコードやステータスワードの意味の詳細については、「CANopen Device Profile Drives 
and Motion Control」を参照してください。本文書は、下記の CiA (CAN in Automation) のサイトから入手で

きます。 

https://www.can-cia.org/can-knowledge/canopen/cia402/ 

before spinning 

while spinning 

after spinning 

2 

3 

4 

1 

https://www.can-cia.org/can-knowledge/canopen/cia402/
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文書のダウンロードは CiA 会員に限られていますが、旧バージョンをインターネット上で見つけることが

できます。 

追加のモータが RZ/T1 ソリューションキットに接続されている場合、このモータの軸（第 2 軸）は、付属

モータの軸（第 1 軸）と同じ方法で制御可能です。TwinCAT®3 のツリー上で“Motor 1”の代わりに“Motor 
2”を展開すると、同じ入力／出力データが表示されますので、同じ方法で変更できます。 
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5. デバッグ用 UART 通信 

5.1 電気的接続 

RZ/T1 は、コントロールボード上のコネクタ P7 に接続された UART のデバッグメッセージを出力しま

す。図 5.1 にコネクタ P7 の周辺回路を示します。コネクタ P7 には 3.3V の標準 CMOS/TTL レベルの受信信

号と送信信号があります。PC に接続するには、適切な RS232 のレベルを得るための外付けトランシーバが

必要です。一般的な UART トランシーバ IC（インターシル、マキシム、ST、リニアテクノロジー、Texas 
Instruments (TI) 等）用の評価ボードを使用されることをお薦めします。 

 

 

図 5.1 RZ/T1 ソリューションキットボードの UART 回路 

 

コネクタ P7 を介してアクセスする UART は、RZ/T1 上の両コアで共有しています。通信は一方向でのみ

行われるため、デバッグメッセージを読むことはできますが、コマンドの入力はできません。 

お使いの PC のシリアルポート用の通信パラメータは、115200bps、8 ビット、パリティ無し、1 ストップ

ビットに設定してください。 

 

5.2 表示例 

図 5.2 に UART インタフェースでのデバッグメッセージの記録例を示します。この例では、メッセージの

内容を説明するコメントを追加しています。メッセージの構成は以下のとおりです。 

• コア（R4 または M3） 

• 軸（m1 または m2） 

• 実際のメッセージ 
 
ステータス（Sts）、エラー（Err）、状況遷移（Trn）などの具体的な意味については、本書には記載しま

せんので、前述の「CANopen Device Profile Drives and Motion Control」を参照してください。最重要メッ

セージについては、図 5.2 のコメントをご確認ください。 
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デバッグ表示 説明
R4 READY! Cortex-R4（モータ制御側）の準備完了
M3 READY! Cortex-M3（EtherCAT通信側）の準備完了
R4 m[1] Cmd[0] INI 初期化コマンド
M3 m[1] Trn[1] Pass CiA 402の状態遷移：state[1]を通過
R4 m[1] Cmd[1] POFF 電源OFFコマンド
M3 m[1] Trn[3] Pass CiA 402の状態遷移：state[3]を通過
R4 m[1] Cmd[3] PON 電源ONコマンド
R4 m[1] Sts[1][0005] モータ制御回路の内部状態
M3m [1] Trn[4] Pass CiA 402の状態遷移：state[4]を通過
R4 m[1] Cmd[4] SON サーボONコマンド
R4 m[1] Sts[2][0047]
R4 m[1] Pos[1] 実際の位置
R4 m[1] Tgt[10000] 目標位置を"10000"に設定
R4 m[1] Sts[1][0086]
R4 m[1] Pos[1532]
R4 m[1] Vel[10]
R4 m[1] Pos[3063]
R4 m[1] Vel[91] 実際の速度
R4 m[1] Pos[6145]
R4 m[1] Pos[9194]
R4 m[1] Sts[2][0087]
R4 m[1] Pos[10000] 目標位置に到達
R4 m[1] Vel[49]
R4 m[1] Vel[0] 停止
R4 m[1] TgtVel[2000rpm](436906ec/100us) 回転速度を"2000" rpmに変更
R4 m[1] Sts[1][0086]
R4 m[1] Sts[2][0087]
R4 m[1] Acc[500]ec/s^2 加速度を"500" ec/s/sに変更
R4 m[1] Sts[1][0086]
R4 m[1] Sts[2][0087]
R4 m[1] Dec[500]ec/s^2 減速度を"500" ec/s/sに変更
R4 m[1] Sts[1][0086]
R4 m[1] Sts[2][0087]
R4 m[1] Tgt[100000] 目標位置を"100000"に設定
R4 m[1] Sts[1][0086]
R4 m[1] Pos[40683]
R4 m[1] Vel[2000] 実際の速度
R4 m[1] Sts[2][0087]
R4 m[1] Pos[100000] 目標位置に到達
R4 m[1] Vel[-4]
R4 m[1] Vel[0] 停止
M3 m[1] Trn[9] Pass CiA 402の状態遷移：state[9]を通過
R4 m[1] Cmd[9] POFF 電源OFFコマンド
R4 m[1] Sts[0][0081]
R4 m[1] Pos[100004]  

図 5.2 デバッグメッセージ記録例 



RZ/T1 グループ  

R01AN3968JJ0103  Rev.1.03  Page 64 of 65 
2019.07.31  

RZ/T1 ソリューションキットを使用した

EtherCAT 経由のモーションコントロール 

6. 参考ドキュメント 

• ドキュメント／アプリケーションノート／サンプルコード 

RZ/T1 グループ初期設定アプリケーションノート 

RZ/T1 グループユーザーズマニュアル：ハードウェア編 

（最新版をルネサスエレクトロニクスホームページから入手してください。） 
 

• テクニカルアップデート／テクニカルニュース 

（最新版をルネサスエレクトロニクスホームページから入手してください。） 
 

• ユーザーズマニュアル：開発環境 

（最新版を各社ホームページから入手してください。） 

IAR 統合開発環境（IAR Embedded Workbench® for Arm）に関しては、IAR ホームページから入手

してください。 

ソフトウェア PLC（TwinCAT®3）に関しては、Beckhoff Automation ホームページから入手してく

ださい。 
 

• CANopen Device Profile Drives and Motion Control 

CiA (CAN in Automation) の以下のサイトから入手してください。 

https://www.can-cia.org/can-knowledge/canopen/cia402/ 
 

 
  

https://www.can-cia.org/can-knowledge/canopen/cia402/
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ホームページとサポート窓口 
ルネサス エレクトロニクスホームページ 

http://japan.renesas.com/ 
 
お問合せ先 

http://japan.renesas.com/contact/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
すべての商標および登録商標は，それぞれの所有者に帰属します。 

http://japan.renesas.com/
http://japan.renesas.com/contact/
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製品ご使用上の注意事項 
ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意事項については、本ドキュメントおよびテク

ニカルアップデートを参照してください。 

1. 静電気対策 

CMOS 製品の取り扱いの際は静電気防止を心がけてください。CMOS 製品は強い静電気によってゲート絶縁破壊を生じることがあります。運搬や保

存の際には、当社が出荷梱包に使用している導電性のトレーやマガジンケース、導電性の緩衝材、金属ケースなどを利用し、組み立て工程にはアー

スを施してください。プラスチック板上に放置したり、端子を触ったりしないでください。また、CMOS 製品を実装したボードについても同様の扱

いをしてください。 

2. 電源投入時の処置 

電源投入時は、製品の状態は不定です。電源投入時には、LSI の内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定です。外部

リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端子の状態は保証できません。同様に、内蔵パワーオン

リセット機能を使用してリセットする製品の場合、電源投入からリセットのかかる一定電圧に達するまでの期間、端子の状態は保証できません。 

3. 電源オフ時における入力信号 

当該製品の電源がオフ状態のときに、入力信号や入出力プルアップ電源を入れないでください。入力信号や入出力プルアップ電源からの電流注入に

より、誤動作を引き起こしたり、異常電流が流れ内部素子を劣化させたりする場合があります。資料中に「電源オフ時における入力信号」について

の記載のある製品は、その内容を守ってください。 

4. 未使用端子の処理 

未使用端子は、「未使用端子の処理」に従って処理してください。CMOS 製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっ

ています。未使用端子を開放状態で動作させると、誘導現象により、LSI 周辺のノイズが印加され、LSI 内部で貫通電流が流れたり、入力信号と認識

されて誤動作を起こす恐れがあります。 

5. クロックについて 

リセット時は、クロックが安定した後、リセットを解除してください。プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した

後に切り替えてください。リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムでは、クロックが十分安定

した後、リセットを解除してください。また、プログラムの途中で外部発振子（または外部発振回路）を用いたクロックに切り替える場合は、切り

替え先のクロックが十分安定してから切り替えてください。 

6. 入力端子の印加波形 

入力ノイズや反射波による波形歪みは誤動作の原因になりますので注意してください。CMOS 製品の入力がノイズなどに起因して、VIL（Max.）から

VIH（Min.）までの領域にとどまるような場合は、誤動作を引き起こす恐れがあります。入力レベルが固定の場合はもちろん、VIL（Max.）から VIH

（Min.）までの領域を通過する遷移期間中にチャタリングノイズなどが入らないように使用してください。 

7. リザーブアドレス（予約領域）のアクセス禁止 

リザーブアドレス（予約領域）のアクセスを禁止します。アドレス領域には、将来の拡張機能用に割り付けられている リザーブアドレス（予約領

域）があります。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスしないようにしてください。 

8. 製品間の相違について 

型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してください。同じグループのマイコンでも型名が違うと、フラッ

シュメモリ、レイアウトパターンの相違などにより、電気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ幅射量などが異なる場合が

あります。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 
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ご注意書き 
1. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説明するものです。お客様の機器・システ

ムの設計において、回路、ソフトウェアおよびこれらに関連する情報を使用する場合には、お客様の責任において行ってください。これらの使用に

起因して生じた損害（お客様または第三者いずれに生じた損害も含みます。以下同じです。）に関し、当社は、一切その責任を負いません。 
2. 当社製品、本資料に記載された製品デ－タ、図、表、プログラム、アルゴリズム、応用回路例等の情報の使用に起因して発生した第三者の特許権、

著作権その他の知的財産権に対する侵害またはこれらに関する紛争について、当社は、何らの保証を行うものではなく、また責任を負うものではあ

りません。 
3. 当社は、本資料に基づき当社または第三者の特許権、著作権その他の知的財産権を何ら許諾するものではありません。 
4. 当社製品を、全部または一部を問わず、改造、改変、複製、リバースエンジニアリング、その他、不適切に使用しないでください。かかる改造、改

変、複製、リバースエンジニアリング等により生じた損害に関し、当社は、一切その責任を負いません。 
5. 当社は、当社製品の品質水準を「標準水準」および「高品質水準」に分類しており、各品質水準は、以下に示す用途に製品が使用されることを意図

しております。 
 標準水準： コンピュータ、OA 機器、通信機器、計測機器、AV 機器、家電、工作機械、パーソナル機器、産業用ロボット等 
 高品質水準： 輸送機器（自動車、電車、船舶等）、交通制御（信号）、大規模通信機器、金融端末基幹システム、各種安全制御装置等 
当社製品は、データシート等により高信頼性、Harsh environment 向け製品と定義しているものを除き、直接生命・身体に危害を及ぼす可能性のあ

る機器・システム（生命維持装置、人体に埋め込み使用するもの等）、もしくは多大な物的損害を発生させるおそれのある機器・システム（宇宙機

器と、海底中継器、原子力制御システム、航空機制御システム、プラント基幹システム、軍事機器等）に使用されることを意図しておらず、これら

の用途に使用することは想定していません。たとえ、当社が想定していない用途に当社製品を使用したことにより損害が生じても、当社は一切その

責任を負いません。 
6. 当社製品をご使用の際は、最新の製品情報（データシート、ユーザーズマニュアル、アプリケーションノート、信頼性ハンドブックに記載の「半導

体デバイスの使用上の一般的な注意事項」等）をご確認の上、当社が指定する最大定格、動作電源電圧範囲、放熱特性、実装条件その他指定条件の

範囲内でご使用ください。指定条件の範囲を超えて当社製品をご使用された場合の故障、誤動作の不具合および事故につきましては、当社は、一切

その責任を負いません。 
7. 当社は、当社製品の品質および信頼性の向上に努めていますが、半導体製品はある確率で故障が発生したり、使用条件によっては誤動作したりする

場合があります。また、当社製品は、データシート等において高信頼性、Harsh environment 向け製品と定義しているものを除き、耐放射線設計を

行っておりません。仮に当社製品の故障または誤動作が生じた場合であっても、人身事故、火災事故その他社会的損害等を生じさせないよう、お客

様の責任において、冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージング処理等、お客様の機器・システムとしての出荷保証を

行ってください。特に、マイコンソフトウェアは、単独での検証は困難なため、お客様の機器・システムとしての安全検証をお客様の責任で行って

ください。 
8. 当社製品の環境適合性等の詳細につきましては、製品個別に必ず当社営業窓口までお問合せください。ご使用に際しては、特定の物質の含有・使用

を規制する RoHS 指令等、適用される環境関連法令を十分調査のうえ、かかる法令に適合するようご使用ください。かかる法令を遵守しないことに

より生じた損害に関して、当社は、一切その責任を負いません。 
9. 当社製品および技術を国内外の法令および規則により製造・使用・販売を禁止されている機器・システムに使用することはできません。当社製品お

よび技術を輸出、販売または移転等する場合は、「外国為替及び外国貿易法」その他日本国および適用される外国の輸出管理関連法規を遵守し、そ

れらの定めるところに従い必要な手続きを行ってください。 
10. お客様が当社製品を第三者に転売等される場合には、事前に当該第三者に対して、本ご注意書き記載の諸条件を通知する責任を負うものといたしま

す。 
11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを禁じます。 
12. 本資料に記載されている内容または当社製品についてご不明な点がございましたら、当社の営業担当者までお問合せください。 
注 1. 本資料において使用されている「当社」とは、ルネサス エレクトロニクス株式会社およびルネサス エレクトロニクス株式会社が直接的、間接的

に支配する会社をいいます。 
注 2. 本資料において使用されている「当社製品」とは、注 1 において定義された当社の開発、製造製品をいいます。 
 

(Rev.4.0-1  2017.11) 
 

本社所在地  お問合せ窓口 
〒135-0061 東京都江東区豊洲 3-2-24（豊洲フォレシア） 

www.renesas.com 

 弊社の製品や技術、ドキュメントの最新情報、最寄の営業お問合せ窓

口に関する情報などは、弊社ウェブサイトをご覧ください。 

www.renesas.com/contact/ 

商標について   
ルネサスおよびルネサスロゴはルネサス エレクトロニクス株式会社の

商標です。すべての商標および登録商標は、それぞれの所有者に帰属

します。 

  

 
 

https://www.renesas.com/
http://www.renesas.com/contact/
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